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Dodatkowe materiały na CD i  FTP:
ftp://ep.com.pl, user: 10460, pass: 0646g3n0

MPLAB i kompilator Hi-Tech
MPLAB IDE jest zintegrowanym środowi-

skiem projektowym umożliwiającym pisanie, 
kompilowanie i  uruchamianie programów dla 
mikrokontrolerów PIC. Jest to też aplikacja ste-
rująca wszystkimi firmowymi programatorami 
debuggerami i emulatorami sprzętowymi. Jeżeli 
chcemy wykorzystywać te narzędzia, to poza nie-
licznymi wyjątkami jesteśmy niejako „skazani” 
na MPLAB. Ponieważ jest ono rozwijane przez 
wiele lat, to ma opinię dopracowanego i wygod-
nego. Co ważne, jest dostępne bezpłatnie. Można 
je pobrać ze strony www.microchip.com.

MPLAB ma spore możliwości, a  opisanie 
wszystkich znacznie wykracza poza ramy kursu. 
Skupimy się tylko na tych niezbędnych do utwo-
rzenia programu, jak tworzenie projektu i środo-
wiska pracy, dodawanie do niego plików, wybór 
kompilatora, ustawienie opcji kompilacji i wybór 
programatora.

Wszystkie pliki źródłowe używane w czasie 
pracy oraz ścieżki dostępu do nich, rodzaj kom-
pilatora i  jego ustawienia, rodzaj programatora 
itp. są zapisywane w pliku projektu. Po każdym 
uruchomieniu MPLAB-a można sobie otworzyć 
wcześniej zapisany projekt i rozpocząć pracę od 
momentu, w którym ostatnio nad nim pracowa-
liśmy.

Nowy projekt można utworzyć z menu Pro-
ject na dwa sposoby: używając kreatora Project 
Wizard lub polecenia New. Przed tworzeniem 
projektu musimy znać typ mikrokontrolera, mieć 
zainstalowany kompilator i utworzyć sobie kata-
log, w którym będzie zapisany projekt i pliki źró-
dłowe. Pliki źródłowe nie muszą być w katalogu 
projektu – można je umieszczać w  dowolnych 
lokalizacjach.

Na potrzeby kursu wybrałem mikrokontro-
ler PIC18F2320 i bezpłatny kompilator języka C 
firmy Hi-Tech dla rodziny PIC 18F w wersji Lite. 
Przykładowy projekt utworzymy, korzystając 
z kreatora Project Wizard. Po uruchomieniu kre-
ator wymaga wybrania z listy typu mikrokontro-

Kurs programowania 
mikrokontrolerów PIC18
Informacje wstępne

Kurs programowania mikrokontrolerów PIC rozpoczynamy od opisu 
narzędzi programowych, sposobu integracji środowiska MPLAB 

z  kompilatorem Hi-Tech oraz prostych programów przykładowych. 
Podajemy też istotne informacje na temat konfigurowania 

mikrokontrolera, w  tym roli poszczególnych bitów, i  wyboru źródła 
sygnału zegarowego.

lera (rysunek 1). Następnie wybieramy język pro-
gramowania i kompilator. MPLAB-IDE pozwala 
na pracę z  wieloma kompilatorami asemblera 
lub języków wyższego poziomu. Kompilatory 
kompatybilne z  MPLAB mają swoje programy 
narzędziowe (kompilator, linker, asembler itp.) 
pogrupowane w  tak zwany Toolsuite. W  oknie 
Active toolsuite wybieramy Hi-Tech, a  w  oknie 
Location ścieżkę dostępu do pliku kompilatora 
(rysunek 2). W kolejnym kroku tworzymy plik 
projektu, wybierając lokalizację i  wpisując na-
zwę projektu (rysunek 3). Jeżeli już mamy pliki 
źródłowe, to można je dodać w następnym kroku 
działania kreatora. Ja wcześniej na potrzeby tego 
przykładu utworzyłem pusty plik main.c w ka-
talogu projektu i mogłem go dodać, jednak do-
dawanie plików można wykonać w dowolnym 
momencie pracy nad projektem.

Po dodaniu plików źródłowych kreator koń-
czy działanie, zapisuje plik projektu o wybranej 
nazwie (tutaj PicTest) i rozszerzeniu .mcp. Poja-
wia się okno, w którym jest umieszczane drzewo 
projektu z  katalogami plików źródłowych (So-

urce Files), nagłówkowych (Header Files), wyni-
kowych (Object Files) i  bibliotecznych (Library 
Files).

Warto wspomnieć o jeszcze jednym elemen-
cie organizacji pracy w MPLAB-ie, a mianowicie 
o przestrzeni roboczej (Workspace). Kreator Pro-
ject Wizard przy tworzeniu projektu automatycz-
nie tworzy plik Workspace o takiej samej nazwie, 

Dodatkowe materiały 
na CD i FTP

Rysunek 1. Wybór mikrokontrolera

Rysunek 2. Wybór kompilatora

Rysunek 3. Utworzenie pliku projektu

Rysunek 4. Dodawanie plików 
źródłowych w kreatorze Project Wizard
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Bardziej zaawansowani użytkownicy mogą 
zmieniać ustawienia w  zakładkach Compiler, 
Linker i Global, ale w naszych zastosowaniach 
wystarczają ustawienia domyślne. Na koniec 
możemy w okienku umieszczonym w pasku na-
rzędziowym ustawić czy plik wynikowy ma być 
typu Debug czy Release. Opcję Debug wybiera 
się wtedy, gdy program będzie debugowany 
sprzętowo np. za pomocą debuggera ICD2, PIC-
KIT2, PICKIT3 itp. Jeżeli plik wynikowy ma już 
końcową postać lub testy działania przeprowa-
dzamy bez debuggera wgrywając go do pamięci 
mikrokontrolera, wybieramy opcję Release. Na 
potrzeby tego kursu należy wybierać Release.

Microchip dołącza do pakietu instalacyjne-
go MPLAB kompilator Hi-Tech Lite dla rodziny 
PIC16. Ponieważ w kursie używamy mikrokon-
trolera z rodziny PIC18, kompilator trzeba ścią-
gnąć ze strony www.microchip.com po uprzed-
nim zarejestrowaniu się. W czasie instalacji po-
branego pliku wybieramy opcję Operate In Lite 
Mode (rysunek 8).

Po zapoznaniu się z nią należy zaakcepto-
wać warunki licencji. Kompilator zainstaluje się 
w domyślnej lokacji. Dokumentacja kompilato-
ra Hi-Tech ( jeżeli został wybrany w projekcie) 
jest dostępna z menu Project -> HI-TECH C Ma-
nual lub po naciśnięciu klawisza F11.

Wersja Lite kompilatora nie nakłada ogra-
niczeń czasowych i rozmiaru kodu. Jest prze-
znaczona do zastosowań edukacyjnych i  nie 
zawiera mechanizmów optymalizacji. Kod 
w  porównaniu z  najlepsza wersją PRO jest 
sporo większy, ale dla naszych celów nie ma 
to znaczenia. 

Projekt jest kompilowany po naciśnięciu 
klawisza F10 lub czarnej ikony kompilacji na 
pasku narzędziowym. Wynik jest przedstawia-
ny w oknie zatytułowanym Output w zakładce 
Build. Kompilator umieszcza tam informacje 
o zajętości wszystkich rodzajów pamięci przez 
plik wynikowy. Jeżeli kompilacja przebiegła 
bez błędów, pojawi się komunikat Build Suc-
cessful. Błędy i  ostrzeżenia są wyświetlane 
w  kolorze niebieskim. Komunikat o  błędzie 
zawiera nazwę pliku, numer wiersza w pliku, 
numer kolumny w wierszu oraz nazwę błędu. 
Wystarczy kliknąć 2 razy na linijkę z komuni-
katem, a edytor automatycznie ustawi wskaź-
nik edycji w pliku źródłowym w wierszu z błę-
dem (rysunek 9).

wyświetlanego po naciśnięciu prawego klawisza 
myszy, gdy kursor jest w oknie projektu.

Utworzenie projektu i  zapisanie przestrze-
ni roboczej nie kończy pracy nad projektem. 
W wielu przypadkach trzeba uzupełnić dodatko-
we opcje projektu w oknie Build Options rozwi-
janym z menu Project. Zawartość tego okna zale-
ży od wybranego Toolsuite, czyli od producenta 
kompilatora.

W przypadku kompilatora Hi-Tech na pew-
no będzie nas interesowała zakładka Directories. 
Można w niej ustawić ścieżkę dostępu do zapi-
sywania pliku wynikowego Oputput Directory 
i ścieżki dostępu do plików nagłówkowych In-
clude Search Patch. W  przypadku ustawiania 
ścieżki dostępu do katalogu z  plikiem wyni-
kowym trzeba pamiętać, by zaznaczyć na dole 
okna  opcję Link In output Directory. Domyślnie 
plik wynikowy jest zapisywany w katalogu pro-
jektu.

Dużo bardziej przydatna jest opcja usta-
wiania ścieżek dostępu dla plików nagłówko-
wych. Pliki nagłówkowe dołącza się instrukcją 
preprocesora #include. Jeżeli plik nagłówkowy 
jest umieszczony w  domyślnej lokalizacji, to 
jest ujęty w  ostre nawiasy np. #include  <htc.
h>. Dołączanie plików z innych lokalizacji wy-
maga podania pełnej ścieżki dostępu lub ścieżki 
w odniesieniu do katalogu projektu. Jeżeli plik 
nagłówkowy jest umieszczony w katalogu pro-
jektu, to jego nazwa jest ujęta w cudzysłów, np. 
#include „test.h”.

W trakcie dołączenia kompilatora do projek-
tu automatycznie są ustawiane ścieżki dostępu 
do domyślnych lokalizacji. Jednak w  projek-
cie używamy swoich plików nagłówkowych, 
wygodnie jest ustawić ścieżkę do tych plików 
i dołączać je tak jak przy lokalizacji domyślnej. 
W oknie Show directories for wybieramy Include 
Search Path i klikamy na przycisk New. W tym 
oknie dodajemy ścieżkę dostępu do katalogu 
z plikami nagłówkowymi. Można w ten sposób 
dodawać więcej niż jedną ścieżkę. Wszystkie 
pliki nagłówkowe ze zdefiniowanymi ścieżkami 
można dołączać przez #include <nawa_pliku.
h>. W  przypadku innych kompilatorów może 
się okazać, że projekt będzie wymagał dodania 
ścieżek dostępu do innych elementów projektu:  
plików bibliotecznych, plików skryptów kompi-
latora itp.

Kompilator Hi-Tech dopuszcza instalowanie 
i używanie różnych swoich wersji w różnych lo-
kalizacjach. Na przykład użytkownik może mieć 
zainstalowane pełną wersję PRO i jednocześnie 
wersję LITE, ale mogą to też być kompilatory dla 
różnych rodzin mikrokontrolerów. Wybór in-
teresującej wersji następuje w zakładce Driver. 
Przyciskami Move Up i Move Down przemiesz-
cza się w nim zainstalowane wersje. Zawsze jest 
wykonywana wersja umieszczona najwyżej, ale 
pod warunkiem, że obsługuje wybrany mikro-
kontroler. Kompatybilność wersji kompilatora 
z mikrokontrolerem można sprawdzić w okien-
ku zatytułowanym Select driver Information and 
supported devices. 

Rysunek 5. Dodawanie nowego pliku 
źródłowego

Rysunek 6. Menu operacji na pliku 
projektu

Rysunek 7. Dodawanie ścieżki dostępu do 
plików nagłówkowych

Rysunek 8. Instalacja wersji Lite

jak plik projektu i o rozszerzeniu .mcw. W prze-
strzeni roboczej można otworzyć więcej niż je-
den projekt i w prosty sposób przełączać jeden 
z nich jako aktywny (Project -> Set Active Pro-
ject). Nazwę przestrzeni roboczej można zmie-
niać z poziomu menu File -> Save Workspace As.

We wcześniej utworzonym projekcie pli-
ki źródłowe dodaje się po kliknięciu prawym 
klawiszem na folderze Source Files. Pojawia się 
wtedy krótkie menu z możliwością dodania pli-
ku, dodania podkatalogu oraz stosowania filtra 
(rysunek 5). Dla nas jest interesująca pierwsza 
pozycja – Add Files. Po jej wybraniu otwiera się 
okno wyboru pliku. W związku z tym, że system 
Windows wyświetla menu okno z opisami w ję-
zyku angielskim, a przyciski standardowe z opi-
sami w języku polskim (np. Otwórz, Anuluj), po 
wskazaniu pliku akceptuje się jego wybór przez 
naciśnięcie Otwórz. Inne operacje na plikach 
projektu, jak usunięcie, edycja i kompilacja, są 
dostępne z  menu kontekstowego (rysunek  6) 
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duża szybkość działania mikrokontrolera, wybie-
rany jest tryb HS (High Speed) lub HSPLL. Dla 
średnich częstotliwości  wybierany jest tryb XT.

W  trybach XT, LP lub HS kwarcowe lub 
ceramiczne rezonatory są dołączone do wypro-
wadzeń OSC1 i OSC2 (rysunek 11). Generatory 
wbudowane w  mikrokontrolery PIC wymagają 
rezonatorów o rezonansie równoległym. Oprócz 
właśnie opisanego głównego oscylatora kwar-
cowego mikrokontroler ma wbudowany drugi 
oscylator dla małych częstotliwości, który rów-
nież można wykorzystać do taktowania mikro-
kontrolera.

Zastosowanie oscylatora z  zewnętrznymi 
elementami RC jako źródła sygnału zegarowego 
z  jednej strony jest rozwiązaniem najtańszym, 
z  drugiej jednak strony charakteryzuje się naj-
mniejszą dokładnością i stabilnością. Oscylator 
RC jest zbudowany tylko z dwóch elementów ze-
wnętrznych: kondensatora i rezystora, a często-
tliwość sygnału zegarowego zależy od napięcia 
zasilania, wartości rezystancji REXT, pojemności 
CEXT i temperatury otoczenia. Z tych powodów ta 
opcja nie będzie nas interesować 

Ciekawą alternatywą dla głównego gene-
ratora kwarcowego jest użycie wbudowanego 
w mikrokontroler wewnętrznego generatora RC 
o  ustalonej częstotliwości, niewymagającego 
żadnych elementów zewnętrznych. Dokładność 
i stabilność jest na poziomie ±1...2% wystarcza-
jącym dla większości zastosowań, a dodatkowo 
ten generator po włączeniu zasilania zaczyna 
oscylować bardzo szybko w porównaniu z gene-
ratorem kwarcowym. Oscylator ma częstotliwość 
8 MHz i jest kalibrowany w procesie produkcyj-
nym. Użytkownik może skalibrować go samo-
dzielnie, zapisując rejestr kalibracji OSCTUNE. 
Maksymalna częstotliwość 8 MHz jest dzielona 
w  bloku postskalera. Przez zapisywanie bitów 
ICRF <2:0> w rejestrze OSCCON (rysunek 12) 
można wybrać jedną z 8 dostępnych częstotliwo-
ści i elastycznie dobrać taktowanie do potrzeb. 
Po włączeniu zasilania domyślenie jest wybrany 
oscylator  o częstotliwości 31 kHz. Jeżeli chcemy 
taktować z wyższą częstotliwością, to po zerowa-
niu trzeba przeprogramować bity ICRF2...ICRF0.

W praktyce będziemy wykorzystywać tryby 
XT i HS oraz tryb wewnętrznego oscylatora RC. 

Bity konfiguracyjne
W  mikrokontrolerach PIC18 w przestrzeni 

adresowej programu o adresach 30000h...3ffffh 
zaimplementowano nieulotną pamięć nastaw, 
umożliwiającą konfigurowanie i  testowanie 
układów. Dostęp do tego obszaru jest możliwy 

–	 INTIO1 – wbudowany generator RC bez 
zewnętrznych elementów RC; sygnał o czę-
stotliwości FOSC/4 jest dostępny na wyprowa-
dzeniu RA6,

–	 INTIO2 – wbudowany generator RC bez ze-
wnętrznych elementów RC; wyprowadzenia 
RA6 i RA7 mogą być wykorzystane jako linie 
portów IO,

–	 EC – taktowanie sygnałem zegarowym z ze-
wnętrznego generatora podawanym na wej-
ście OSC1/CLOCIN,

–	 ECIO – taktowanie sygnałem zegarowym 
z zewnętrznego generatora podawanym na 
wejście OSC1/CLOCIN i  z  linią RA6 jako 
port I/O.
Mikrokontrolery PIC18F mogą pracować 

w  tak szerokim zakresie częstotliwości, że za-
projektowanie jednego oscylatora kwarcowego, 
który generowałby sygnał zegarowy o częstotli-
wości od pojedynczych kHz do dziesiątek MHz, 
jest praktycznie niemożliwe. W związku z  tym 
Microchip zastosował programowany  główny 
generator. Pozwoliło to na podzielenie zakresu 
częstotliwości sygnału zegarowego na podzakre-
sy LP, XT i HS. Tryb LP (Low Power) jest prze-
znaczony do generowania niskich częstotliwości 
sygnału zegarowego, a co za tym idzie niskiego 
poboru mocy. W przypadku, kiedy potrzebna jest 

Taktowanie mikrokontrolera
Praca jednostki centralnej i  wszystkich 

układów peryferyjnych mikrokontrolera jest 
synchronizowana sygnałem zegarowym, któ-
rego źródłem może być generator zewnętrzny 
(kwarcowy lub RC) albo wbudowany w struktu-
rę mikrokontrolera kompletny oscylator tzn. bez 
konieczności stosowania elementów zewnętrz-
nych RC (rysunek 10).

Układ generatora jest dość rozbudowany 
i  pozwala na programowe wybieranie jednego 
z 10 trybów taktowania:

–	 LP – wbudowany generator kwarcowy z ze-
wnętrznym kwarcem „zegarkowym” o czę-
stotliwości 32 kHz,

–	 XT – wbudowany generator kwarcowy 
z kwarcami o średnich częstotliwościach (do 
4 MHz),

–	 HS – wbudowany generator kwarcowy 
z  kwarcami o  najwyższych częstotliwo-
ściach (4...20 MHz),

–	 HSPLL – wbudowany generator kwarcowy 
z  kwarcami o  najwyższych częstotliwo-
ściach (4...10 MHz) z możliwością jej pod-
wyższenia przez PLL,

-	 RC – wbudowany generator RC z zewnętrz-
nymi elementami RC dołączanymi do wy-
prowadzenia OSC1/CLKIN i  z  wyjściem 
sygnału o częstot-
liwości FOSC/4 na 
RA6,

-	 RCIO – wbudo-
wany generator 
RC z  zewnętrz-
nymi elementa-
mi RC dołącza-
nymi do wypro-
wadzenia OSC1/
CLKIN; wypro-
wadzenie RA6 
może być wyko-
rzystywane jako 
linia I/O,

Rysunek 9. Błędy kompilacji

Rysunek 10. Układ generatora taktującego mikrokontroler

Rysunek 11. Generator z oscylatorem 
kwarcowym lub ceramicznym
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Rysunek 14. Ustawienie bitów konfiguracyjnych

Rysunek 12. rejestr sterujący OSCCON

sposób wykorzystuje okno Configuration Bits 
otwierane z zakładki Configuration (rysunek 14). 
Można tu, klikając na kolumnę Setting, w prosty 
sposób ustawić bity konfiguracyjne, tak jak sobie 
tego życzymy.

To rozwiązanie, chociaż wygodne, ma wadę. 
Jeżeli będziemy chcieli plikiem wygenerowa-
nym w projekcie zaprogramować pamięć mikro-
kontrolera, nie mając całego projektu, to nie ma 
dostępu do informacji o bitach konfiguracyjnych. 
Z tego powodu lepiej jest konfigurację umieścić 
w programie. Zaznaczamy wtedy okienko Confi-
guration Bits set In Code i MPLAB „wie”, że konfi-
guracje trzeba pobrać z pliku wynikowego (.hex) 
projektu. W kompilatorze Hi-Tech zdefiniowane 
jest makro __CONFIG, w którym można ustalić 
bity konfiguracyjne, na przykład: 

__CONFIG (HS&WDTDIS&LVPDIS&PWRTE
N&FCMDIS&BOREN);

Definicja argumentów makra jest umiesz-
czona w  pliku nagłówkowym mikrokontrolera 
pic18F2320.h. Umieszczenie  makra w  pliku 
programu powoduje, że po wczytaniu pliku wy-
nikowego powstałego w wyniku kompilacji auto-
matycznie zostaną odpowiednio ustawione bity 
konfiguracyjne. Jest to również bardzo wygodne 
rozwiązanie, bo zwalnia każdorazowego usta-
wiania bitów po otwarciu programu MPLAB.

W  każdym projekcie kursu takie makro 
zostanie zdefiniowane i układ będzie skonfigu-
rowany. Jednak zachęcam do dokładnego przej-
rzenia opisu bitów konfiguracyjnych, żeby móc 
świadomie konfigurować mikrokontroler sto-
sownie do własnych wymagań.

Tomasz Jabłoński, EP
tomasz.jablonski@ep.com.pl

Rysunek 13. Rejestr konfiguracyjny 
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11xx  RC
1001 INTIO1
1000 INTIO2
0111 RCIO
0110 HSPLL
0101 EC
0100 ECIO
0010 HS
0001 XT
0000 LP
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Bit 7 IDLEN
Tryb IDLE – rdzeń nie jest taktowany w  trybie 
zarządzania energią 
Tryb RUN – rdzeń jest taktowany w  trybie 
zarządzania energią
Bity 6-4  IRCF <2:0>
111 8 MHz
110 4 MHz
101 2 MHz 
100 1 MHz
011  500 kHz
010  250 kHz
001  125 kHz
000 31 kHz domyślne
Bit3 OSTS – bit statusu
Czas OST upłynął – taktowanie sygnałem zega-
rowym z  oscylatora głównego
Czas OST upłynął – oscylator główny nie jest 
gotowy 
Bit 2 IOFS – bit statusu 
Wewnętrzny oscylator stabilny
Wewnętrzny oscylator niestabilny
Bity 1,0 SCS <1:0> 
1x taktowanie wewnętrznym oscylatorem RC
01 taktowanie drugim oscylatorem kwarcowym
00 taktowanie głównym oscylatorem kwarcowym

tylko w trakcie programowania mikrokontrolera. 
Znajomość bitów konfigurujących jest niezbęd-
na, bo bez prawidłowych nastaw programowany 
układ może nie działać w ogóle lub będzie dzia-
łał źle.

Wiemy już, że sygnał zegara taktującego 
może pochodzić z wielu różnych źródeł. Rodzaj 
generatora taktującego mikrokontrolerem progra-
muje się przez zapisanie rejestru konfiguracyj-
nego CONFIG1H umieszczonego pod adresem 
30001hex – rysunek 13 . 

Bit IESO jest używany do odblokowania 
funkcji startu układu na wewnętrznym genera-
torze RC do momentu ustabilizowania się drgań 
oscylatora kwarcowego (Two-Seed Start-Up). Ma 
to oczywiście znaczenie, kiedy zależy nam na 
szybkim „starcie” układu w konfiguracji z oscy-
latorem kwarcowym. 

Bit FSCM steruje włączaniem funkcji Fail 
Safe Clock Monitor. Kiedy jest odblokowana, 
wtedy w przypadku problemów ze startem lub 
pracą oscylatora kwarcowego taktowanie jest au-
tomatycznie przełączane na wewnętrzny gene-
rator RC. Warto wtedy tak zaprogramować OSC-
CON, by sygnał zegarowy z tego generatora miał 
taką samą lub zbliżoną częstotliwość do kwarcu.

Dokładne opisywanie wszystkich bitów 
rejestrów konfiguracyjnych nie jest konieczne. 
Wszystkie potrzebne informacje dotyczące konfi-
guracji można znaleźć w dokumentacji technicz-
nej mikrokontrolera w dziale Special Features of 
The CPU.

Jednak w każdym projekcie musimy dokład-
nie ustalić konfigurację, bo w  skasowanej pa-
mięci wszystkie bity są jedynkami. Konfigurację 
można zaprogramować na 2 sposoby. Pierwszy 
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